Course Project 
DeVry University
College of Engineering and Information Sciences
Module 6: Networking and security

Objectives
· To learn how to install the ESP32 drivers and the board
· To learn how to setup the ESP32 board to use the Arduino IDE
· To learn how to test the ESP32 board in scanning detectable networks
· To learn how to configure the ESP32 board as a soft access point
· To test some of the ESP32 board components
· To practice writing programs using the Arduino IDE

Introduction
This part of the project shows how to install the ESP32 board and drivers and test its WiFi capabilities and on board hardware resources. The intention is to get you started on this board and use this part of the assignment as a reference for future installation of the board. Two main components will be discussed: Arduino Setup for ESP32 on Windows and ESP32 board WiFi and hardware testing. We will create a web server using the ESP32 board to allow you to remotely control a light. In addition, you can also wire the motion sensor as well to the ESP32 board for a full home security system. 
Steps
1) Setting up your Router

· Using an Ethernet cable connect your mini router WAN port to your home router and power your mini router up using the Micro USB cable provided.
· Using your PC connect to your mini router using the default SSID (GL-XXXXX-xxx) written on the router box and the default password (goodlife)
· Go to your browser and type: http://192.168.8.1
· Enter the password when asked
· Choose language and time zone (in our case we use: English for language, and America/Chicago for time zone.)
· Now you will be presented with the following window:

[image: ]
[bookmark: _GoBack]Router page
Click on wireless logo  [image: ]  then this window will open:
[image: ]
Settings
[image: ]Click on setting: The following window will open where you can enter your own  SSID and PW:Change wireless settings


Change the SSID and Password to your own: 
To be able to connect to your own mini router, I suggest that you use your name as part of the mini router’s SSID. In this case OmarCEIS100 is used for my SSID (see below), also choose a password (minimum of 8 characters)

[image: ]
New Wireless settings
Press submit. You should see Update successfully.

Testing your newly configure router network: use your laptop or your smart phone to check the new configuration. Here is a snap shot of my newly configured mini router.  
 
[image: ]
Connect to router




2) Arduino Setup for ESP32 on Windows

IMPORTANT NOTE:
1. If this is your first time installing the ESP32 on the Arduino IDE, simply follow the installation procedure described below:

2. If you’ve already installed the ESP32 add-on using the old method, you should remove the espressif folder first. Go to the end of this post to learn how to remove the espressif folder.
1. Installing the ESP32 Board
To install the ESP32 board in your Arduino IDE, follow these next instructions:
1) Open the preferences window from the Arduino IDE. Go to File> Preferences
[image: https://i2.wp.com/randomnerdtutorials.com/wp-content/uploads/2016/12/arduino-ide-open-preferences.png?resize=196%2C340&ssl=1]
2) Enter https://dl.espressif.com/dl/package_esp32_index.json into the “Additional Board Manager URLs” field as shown in the figure below. Then, click the “OK” button:
[image: ]
https://dl.espressif.com/dl/package_esp32_index.json
3) Open boards manager. Go to Tools > Board > Boards Manager…
[image: https://i1.wp.com/randomnerdtutorials.com/wp-content/uploads/2018/06/boardsManager.png?resize=628%2C568&ssl=1]
4) Search for ESP32 and press install button for the “ESP32 by Espressif Systems“:
[image: https://i1.wp.com/randomnerdtutorials.com/wp-content/uploads/2018/06/installing.png?resize=786%2C443&ssl=1]
5) That’s it. It should be installed after a few seconds.




Download and Install the Serial Driver to use with the ESP32 board
To program the ESP32 Board, your development platform (PC, Mac, Linux) needs to detect the Serial-To-USB adapter soldered onto the ESP32 module. This ESP32 development module has built in a high-quality Labs CP210x Single-Chip USB to UART Bridge with Micro USB connector that baud rates up to 921600. You can download and install the driver from here: https://www.silabs.com/products/mcu/Pages/USBtoUARTBridgeVCPDrivers.aspx
[image: ]
Download Development module


Extract the zipped folder: CP210x_Windows_Drivers
The contents will look like the following:
[image: ]
Folder contents


One way to install the driver is to double click on the application file (CP210xVCPInstaller_x64) shown above.
NOTE: You can also download this folder from the Files section of the course.

Testing the ESP32 board

1. Open a new Arduino Sketch in the Arduino IDE
a) To add the ESP32 board, go to Tools > Board > DOIT ESP32 DEVKIT V1
b) Add the correct port. With the ESP32 board firmly connected to the breadboard, connect the ESP32 board to your computer using a USB cable. Go to device manager and note the com port listed there (COM4 listed below). 
c) [image: ]
Device manager
d) [image: C:\Users\D99003734\AppData\Local\Microsoft\Windows\INetCache\Content.Outlook\UQ163ZBP\20180920_161825.jpg]
ESP32 attached to breadboard
Next connect an LED light to the breadboard. The negative side to the blue rail and the positive side connect to pin D13 on the ESP32 board. Connect the GND (ground) to the blue rail as shown below.
[image: C:\Users\ginac\AppData\Local\Temp\SNAGHTML113a5029.PNG]
Figure 40: ESP32 with light
That is all, you should now be ready to use your ESP32 board. 
-Make sure the upload speed is 115200
-Make sure the board is the DOIT ESP32 DEVKIT V1
-Be sure you have the correct com port selected. Note  - the com port option will not appear until you connect the board to your laptop
[image: ]
Figure 43: Board setup

Testing the WiFi Setup
a) Test the WiFi Scanner using the following sketch: File > Examples > WiFi > WiFiScan . Verify, upload, and run. Important: While you are uploading the sketch, press and hold the boot button down until you see “Done Uploading” On the output display. Then open the Serial Monitor. Next press the EN button to reset. You will see a list of networks showing.
[image: ]
Figure 44: Test wifi scan


Wait until you see the writing list at 100% to stop holding the boot button:
[image: ]
Figure 45: WifiScan
Then open the Serial Monitor and change the baud rate to 115200 and copy and paste the list of discovered networks
Sample Result:
scan start
scan done
[image: ]
Figure 46: Serial monitor showing networks

Note: if you try to open the serial monitor while the code is uploading you will get the following error. Also be sure the baud rate in the lower corner is set to 115200.
[image: ]
Figure 47: Possible error
b) Create a web server. We will be using the following code and your home network however you will need to make some changes:
· You can use the instructions at the end of this document to set up your router and use your own router for the following code.
· In this code you will see the following commands
 const char* ssid     = "*******";
const char* password = "*********";
· You will need to change the SSID to your own network. You can use the SSID of your home wifi network or the router. 
· Change the password to your own password on your router. You should have a password on your router. Be sure your settings match those below:
· Board = DOIT ESP32 DEVKIT V1
· Upload Speed: 115200
· Port: COMx where x is greater than 2. You will see an option for the board com port once you plug it in.
· Change the “Your Name” in the first line of the web site to your own name. In the code below:
client.print("Welcome to Your Name website!<br>"); Replace with your name
[image: ]
	#include <ETH.h>
#include <WiFi.h>
#include <WiFiAP.h>
#include <WiFiClient.h>
#include <WiFiGeneric.h>
#include <WiFiMulti.h>
#include <WiFiScan.h>
#include <WiFiServer.h>
#include <WiFiSTA.h>
#include <WiFiType.h>
#include <WiFiUdp.h>

/*
 WiFi Web Server 

 A simple web server that lets you blink an LED via the web.
 This sketch will print the IP address of your WiFi Shield (once connected)
 to the Serial monitor. From there, you can open that address in a web browser
 to turn on and off the LED on pin 13.

 If the IP address of your shield is yourAddress:
 http://yourAddress/H turns the LED on
 http://yourAddress/L turns it off

 This example is written for a network using WPA encryption. For
 WEP or WPA, change the Wifi.begin() call accordingly.

 Circuit:
 * WiFi shield attached
 * LED attached to pin 13

 
 
 */

const int LED=13;
const char* ssid     = "********";  //Change the SSID of YOUR network
const char* password = "*********"; //Change to the password of YOUR network
int status=WL_IDLE_STATUS;
WiFiServer server(80);
 int val = 0;    
void setup()
{
    Serial.begin(115200);
    pinMode(LED, OUTPUT);      // set the LED pin mode

    delay(10);

    // We start by connecting to a WiFi network

    Serial.println();
    Serial.println();
    Serial.print("Connecting to ");
    Serial.println(ssid);

    status=WiFi.begin(ssid, password);

    while (status != WL_CONNECTED) {
      Serial.println(WiFi.status());
        delay(3000);
        Serial.print(".");
           status= WiFi.begin(ssid, password);
    }

    Serial.println("");
    Serial.println("WiFi connected.");
    Serial.println("IP address: ");
    Serial.println(WiFi.localIP());
    
    server.begin();

}

int value = 0;

void loop(){
 WiFiClient client = server.available();   // listen for incoming clients

  if (client) {                             // if you get a client,
    Serial.println("New Client.");           // print a message out the serial port
    String currentLine = "";                // make a String to hold incoming data from the client
    while (client.connected()) {            // loop while the client's connected
      if (client.available()) {             // if there's bytes to read from the client,
        char c = client.read();             // read a byte, then
        Serial.write(c);                    // print it out the serial monitor
        if (c == '\n') {                    // if the byte is a newline character

          // if the current line is blank, you got two newline characters in a row.
          // that's the end of the client HTTP request, so send a response:
          if (currentLine.length() == 0) {
            // HTTP headers always start with a response code (e.g. HTTP/1.1 200 OK)
            // and a content-type so the client knows what's coming, then a blank line:
            client.println("HTTP/1.1 200 OK");
            client.println("Content-type:text/html");
            client.println();

            // the content of the HTTP response follows the header:
            client.print("Welcome to Your Name website!<br>"); //Change to your name
            client.print("Click <a href=\"/H\">here</a> to turn the LED on.<br>");
            client.print("Click <a href=\"/L\">here</a> to turn the LED off.<br>");

            // The HTTP response ends with another blank line:
            client.println();
            // break out of the while loop:
            break;
          } else {    // if you got a newline, then clear currentLine:
            currentLine = "";
          }
        } else if (c != '\r') {  // if you got anything else but a carriage return character,
          currentLine += c;      // add it to the end of the currentLine
        }

        // Check to see if the client request was "GET /H" or "GET /L":
        if (currentLine.endsWith("GET /H")) {
          digitalWrite(LED, HIGH);               // GET /H turns the LED on
        }
        if (currentLine.endsWith("GET /L")) {
          digitalWrite(LED, LOW);                // GET /L turns the LED off
        }
      }
    }

    // close the connection:
    client.stop();
    Serial.println("Client Disconnected.");
  }
  
}



Save this code as WifiServer and upload this code to the board with your ESP32. Hold the boot button while it is uploading and let go once you see “Done Uploading”. Open the serial monitor. Then press the EN button to reboot. You should see the following:
[image: ]
Figure 48: Web server

This means your web server is located at the address above. The address for this example is 192.168.15.131

Now open a web browser. Put the address of your web server with http:// in front in the address bar. Example: http://192.168.15.131
Now click the buttons to turn the LED on from your browser. You can also use your phone. 

[image: ]
Figure 49: Using the web server
You can also attach your motion sensor and buzzer to this circuit as well. Connect the VIN on the ESP32 board to the red positive rail. Connect the positive side of the motion sensor to the red positive rail. Connect the middle wire of the motion sensor to D14 on the ESP32 board  and connect the negative wire of the motion sensor to the blue negative rail. Attach the buzzer to the breadboard. Connect the negative side of the buzzer to the negative rail of the breadboard. Attach the positive side of the buzzer to D12. Keep the LED the same. Save and upload the following code. You can control the light from the web server and pass your hand over the motion sensor to activate the buzzer. Congratulations! You have created an IoT home security system.
[image: C:\Users\D99003734\AppData\Local\Microsoft\Windows\INetCache\Content.Outlook\UQ163ZBP\20180921_232409.jpg]
Figure 50: Buzzer and Motion sensor connection
[image: Image]
Figure 51: Closeup on buzzer

#include <ETH.h>
#include <WiFi.h>
#include <WiFiAP.h>
#include <WiFiClient.h>
#include <WiFiGeneric.h>
#include <WiFiMulti.h>
#include <WiFiScan.h>
#include <WiFiServer.h>
#include <WiFiSTA.h>
#include <WiFiType.h>
#include <WiFiUdp.h>

/*
 WiFi Web Server 

 A simple web server that lets you blink an LED via the web.
 This sketch will print the IP address of your WiFi Shield (once connected)
 to the Serial monitor. From there, you can open that address in a web browser
 to turn on and off the LED on pin 13.

 If the IP address of your shield is yourAddress:
 http://yourAddress/H turns the LED on
 http://yourAddress/L turns it off

 This example is written for a network using WPA encryption. For
 WEP or WPA, change the Wifi.begin() call accordingly.

 Circuit:
 * WiFi shield attached
 * LED attached to pin 13
*Buzzer attached to 12
*PIR attached to 14

 
 
 */

const int LED=13;
const int buzzer=12;
const int PIR=14;
const char* ssid     = "********";  //Change the SSID of YOUR network
const char* password = "*********"; //Change to the password of YOUR network
int status=WL_IDLE_STATUS;
WiFiServer server(80);
 int val = 0;    
void setup()
{
    Serial.begin(115200);
    pinMode(LED, OUTPUT);      // set the LED pin mode
   pinMode(buzzer, OUTPUT);      // declare buzzer as output
  pinMode(PIR, INPUT);     // declare sensor as input

    delay(10);

    // We start by connecting to a WiFi network

    Serial.println();
    Serial.println();
    Serial.print("Connecting to ");
    Serial.println(ssid);

    status=WiFi.begin(ssid, password);

    while (status != WL_CONNECTED) {
      Serial.println(WiFi.status());
        delay(3000);
        Serial.print(".");
           status= WiFi.begin(ssid, password);
    }

    Serial.println("");
    Serial.println("WiFi connected.");
    Serial.println("IP address: ");
    Serial.println(WiFi.localIP());
    
    server.begin();

}

int value = 0;

void loop(){
 WiFiClient client = server.available();   // listen for incoming clients

  if (client) {                             // if you get a client,
    Serial.println("New Client.");           // print a message out the serial port
    String currentLine = "";                // make a String to hold incoming data from the client
    while (client.connected()) {            // loop while the client's connected
      if (client.available()) {             // if there's bytes to read from the client,
        char c = client.read();             // read a byte, then
        Serial.write(c);                    // print it out the serial monitor
        if (c == '\n') {                    // if the byte is a newline character

          // if the current line is blank, you got two newline characters in a row.
          // that's the end of the client HTTP request, so send a response:
          if (currentLine.length() == 0) {
            // HTTP headers always start with a response code (e.g. HTTP/1.1 200 OK)
            // and a content-type so the client knows what's coming, then a blank line:
            client.println("HTTP/1.1 200 OK");
            client.println("Content-type:text/html");
            client.println();

            // the content of the HTTP response follows the header:
            client.print("Welcome to Your Name website!<br>"); //Change to your name
            client.print("Click <a href=\"/H\">here</a> to turn the LED on.<br>");
            client.print("Click <a href=\"/L\">here</a> to turn the LED off.<br>");

            // The HTTP response ends with another blank line:
            client.println();
            // break out of the while loop:
            break;
          } else {    // if you got a newline, then clear currentLine:
            currentLine = "";
          }
        } else if (c != '\r') {  // if you got anything else but a carriage return character,
          currentLine += c;      // add it to the end of the currentLine
        }

        // Check to see if the client request was "GET /H" or "GET /L":
        if (currentLine.endsWith("GET /H")) {
          digitalWrite(LED, HIGH);               // GET /H turns the LED on
        }
        if (currentLine.endsWith("GET /L")) {
          digitalWrite(LED, LOW);                // GET /L turns the LED off
        }
      }
    }

    // close the connection:
    client.stop();
    Serial.println("Client Disconnected.");
  }
  
       val = digitalRead(PIR);  // read input value

   if (val == HIGH) {            // check if the input is HIGH
    digitalWrite(buzzer, HIGH);  // turn buzzer ON
     
     }
    else {
     digitalWrite(buzzer, LOW); // turn Buzzer OFF
     
   }
}
[image: ]
Figure 52: Pin mapping

Deliverables 
· Complete the Course Project Powerpoint Deliverable
· Include a picture of your circuit 
· Screenshot of router main page
· Screenshot of web server


image2.png
()




image3.png
<3 | 3 GLiNet

192.168.8.1

Advanced settings >>

Cloud Share UPnP server OpenVpn

Settings

e
SETTINEE Wireless Status Setting LAN IP
10.0.0.64
DHcP Radio Settings 2.4G
Mode 11n (300M)
Channel  auto
WAN access Power 20 i I
disabled
83 AP 2.4G
1 Devices SsiD GL-MT300N-V2-e10
DVGDVX-LAB001 Encryption psk-mixed
WDS 1
P 192.168.8.1
0%> No devices Status on
Firmware .
226





image4.png
GLiNet X | + v

O @ @ 192.168.8.1

J( English

Wireless Settings

Mode
Channel
SSID

Encryption

Password

300M (11ng)
Auto
GL-MT300N-V2-e10

WPA/WPA2 Mixed &)

Keep blank to keep pag





image5.png
B 8|0 cune x|+ v En X
< o @ e * %L e

Wireless Settings

ooy ©
o ]

omar_ces100

WeAWPAZ Mo @)





image6.png
) N

aﬁ

~

Network & Internet settings

Omar_CEIS100
Connected, secured

Properties

GL-AR750-9d6
Secured

HOME-15F2
Secured

xfinitywifi
Open

GL-AR750-9d6-5G
Secured

zwolinski1

Disconnect

Change settings, such as making a connection metered.

7

Omar_CEIS100 Airplane mode hotspot

2




image7.png
@ ESP32_data_logging | Arduino 1.

Edit Sketch Tools Help

New ctleN
Open..  ctls0

Open Recent >
Sketchbook >
Examples >
Close ctlew

Save ctes
Savehs..  CtlsShiftsS

PageSetup  CtrlShift-P
Print Ctri+p.





image8.png
Preferences

Settings | Network

Stetchbooklocaton:
(C:\sers\Gina\PocumentsArcuin|
Editor language: ‘System Defauit ~
Editor fontsie: =
Interface scale: Automate [ 100 % % (requres restartof Arano)
Theme: Default theme | (requires restart of Arduino)
Show verbose output during: [] compiation [] upload
Comper warmings: None
[ Display line numbers.
[ Enable Code Foldng

Verify code after upload

(] Use external citor

| Aggressively cache compied core

Ched for updates on tartup.

Update setch s to new extension on save (pde -> ino)
Save when verfing or ploading

‘Addtonal Boards Manager URLS: | tips://d. espressf.com/d/package _esp32_index.json
More preferences can be edited drectly in the fie:

C:\Users\Gina AppDatalL ocal\Arduino 15lpreferences.txt

(editonly when Arcuino s not running)

(requires restart of Arduino)





image9.png
& Code_Test | Arduino 185 - o X

Auto Format CtrleT
Archive Sketch
Code_Test Fix Encoding & Reload
Serial Monitor CtrlShift-M
Serial Plotter CtrleShift+L.
‘Arduino AVR Boards.
WIFi101 Firmware Updater Arduino Yin

4@ Arduino/Genuino Uno

Board: "Arduino/Genuino Uno'

Arduino Duemilanove or Diecimila

Port
/7 Load 1| it Arduino Nano

#include Arduino/Genino Mega or Mega 2560
#include |  Programmen AVRSP i T Aduino Mega ADK

Bum Bootloader Arduino Leonardo

#include <OneWire.h> e
< Arduino)/Gentino Micro
Arduino Esplora
Arduin Mini

Arduino Ethernet
Arduino Fio

Arduino BT

LityPad Arduino USE
LiiyPad Arduino
Arduino Pro o Pro Mini
Arduino NG or older





image10.png
@ Boards Manager

Type [f

esp32 by Espressif Systems
Boards includad in this package:
ESP32 Dev Module, WEMOS LoLin32.
More infe

N VR« (5/5). Donrlosded 30,2256 of 1257158





image11.jpg
Download for Windows 7/8/8.1/10 (v6.7.5)

Platform Software Release Notes

g Windows 7/8/8.1/10 /Ci B) (Default) Download VCP Revision History

Download VCP with Serial Enumeration (5.3 MB,
110 oS ° & Download VCP Revision History

2R Windows 7/8/
Learn More »





image12.jpg
1 x64

" x86

SF CP210xVCPInstaller x64

SF CP210xVCPInstaller x86

[] dpinst
SLAB_License_Agreement_VCP_Windows
=4 slabvep

&) slabvep
Vv6-7-5-driver-release-notes

5/22/2018 3:23 PM

5/22/2018 3:23 PM

4/15/2018 12:26 PM
4/15/2018 12:26 PM
4/15/2018 12:26 PM
4/15/2018 12:26 PM
4/15/2018 12:26 PM
4/15/2018 12:26 PM
4/15/2018 12:26 PM

File folder

File folder
Application
Application

XML Document
Text Document
Security Catalog
Setup Information

Text Document




image13.png
& Device Manager
Ele Acton View Help

L= =k

v & DVUCOLD9003734
> 1 Audio inputs and outputs
3 @ Batteres
» © Bluetooth

> =2
> Diskdrives

> [ Display adapters

> @ Humen Interface Devices

> @ IDE ATA/ATAPI controllers

> 3n Imaging devices

> E= Keyboards

5 @ Mice and other pointing devices
> [ Monitors

> (5 Network adapters

> = Network Infrastructure Devices
v K7 Other devices

Base System Device

v @ Ports (COM&LPT)

@ Silcon Labs CP210x USB to UART Bridge (COM4)

> R Print queues
> 5 Printers

> [ Processors

> 190 D host adapters
> B Security devices
= pong





image14.jpeg




image15.png




image16.png
0 p i Find -
TimesNewRo - |10 ~| A" A" Aa~ M L | AaBbCcDi AaBbCcDi AaBbCel aasbcer AaBbCcl AaBbCcl AaBbCcI AaBbCe AaBbCD¢| Partq: Step1:. a AaBbC 1) AaBbC AaBbC
22 Replace.
Paste o rormatpainter | B 1 U b X, X - A- =- & - - | TBodyTe. TBodyTe. TCaption  Code  Headingl Heading2 Heading3 Heading6 TlabSect.. | TNormal | TPart Head fStepHead TSut 7SubStep. Title 1\ Select~
Some settings are managed by your organization. - . . e e
~ 2) Testing the W11 Setup
Wi-Fi Two tests will be performed as follows:
rk & Internet SimpleWiFiServerGinaMod | Arduino 1.8:6 (Windows Store 1.8.14.0) _ o x |n(Figurel-6).
On File Edit Sketch Tools Help the boot button

n = itor. Next press the

Archive Sketch

SImPIEWIFISEl iy Encoding & Reload =
P Menage Libraris. Crlsshift+1 2 o X
= Serial Monitor Ctrlsshift-M
Cisco = Ethemet Serial Plotter Ctrlsshift-L
® Diakup Wi-Fi Sense WFi101 Firmware Updater

Board: "DOIT ESP32 DEVKIT V1" > | 2
@ VPN Flash Frequency: "80MHz" ~

Upload Speed: "115200"

Wi-Fi Sense connects you to suggested Wi-Fi hotspots.
Core Debug Level:"None" >

Port: "COM4" >

= Airplane mode
well-defined

Remember, not all Wi-Fi networks are secure.
ontrols Systems;

Get Board Info

) Mobile hotspot

i rogrammer: "AVRISP mil" >
Mozilla ppropriate to Prog RISP mkl

GECS S Data usage

Burn Bootloader

ces; €01, CO3

. Proxy 1d; O 6, CO 7 Done Saving

Dropbox

10:44 AM
™)

=L 9/22/2M8

92212018




image17.jpg
File Edit Sketch Tools Help

New ctisN
Open..  Cul+0

Open Recent >
Sketchbook >
Examples, |
Close Ctrlsw

Save ctilss

SaveAs..  Crlsshiftss

Page Setup  Ctrl+Shift+P.

Print Cul+p
Preferences ~ Ctrl+Comma
Quit cul+Q

sertal.princln(

i 100 ()
«

tad prineln(

"

scanvetworks willl

EEPROM
ESP32
ESPmDNS.
HTTPClient
Preferences
SD(esp32)
SD_MMC
SimpleBLE
SPIFFS

Ticker

Update

WiFi
WiiClientSecure

Examples from Custom Libraries
Blynk

Cayennel PP

CayenneMQTT

DHT sensor library

DHT sensor library for ESPx
ESP32 BLE Arduino

ESP32httpUpdate
Growe 101 RGR Racklinkt

ETH_LAN8720
ETH_LANB720_internal_clock
ETH_TLK110
SimpleWiFiServer
ki WiFiBlueToothSwitch
WiFiClient
WiFiClientBasic
3 WiriClienttvents
> WiFiClientStaticlP
3 WRIPG
3 WiRiMlt
3 WifismartConfig
3 WiFiTelnetToSerial
'WiFiUDPClient
WPS





image18.png
wifiaccesspoint | Arduino 1.8.6 (Windows Store 18.140) - o x
Eile Edit Sketch Tool

L

Done uploading.





image19.png
@ coms

s: Homenet32015 (-33)*
6: Tel672632 (-33)*
7: Evansnetwork_26_2GEXT (-35)*

scan start
scan done

7 networks found

1: ginerik (-50)*

2: Homenets2015-guest (-83)

3: Homenet32015 (-24)%
161672692 (-92)*

Madison01 (-83)*
Evansnetwork_2G_2GEXT (-93)*
NETGEARGS (-34)*

Autoscroll [] Show timestamp.

115200baud

Clear output





image20.png
WiFiScan | Arduino 186 (Windows Store 1.8.14.0) - o x

File Edit Sketch Tools Help

#include

setup ()

Serial.begin(115200) ;

WiFL.mode
WiFL.a:
delay

100);

Serial.println("S

NodeMGU-325, B0MHz, 921600 on COMA.




image21.png
@ coms ]
I
%
irs connected.
12 adaress:
192.168.15.131
BN acR | [115200boud | | Clearouput

& Autosrol (] how tmestam





image22.png
MTA Certification Su... X | <= CourselWrterfor Canv... X | |/ Week7:Lab X | 0 Files % | € PR motion detector —.

€ 192.168.15.131/L e Search e ¥ &0

% | [0 togintoTrello X | oo ESPR2erroruploading.. X hitpy//1216815131/L X Emor x|+ — [=ded]

Welcome to Your Name website!

. Click here to turn the LED on
Click here to tum the LED off.





image23.jpeg
)
2
E
-
=

E
-
\~





image24.jpeg




image25.jpg
)|

SvP

SWN |

DAC1
DAC2

(pd)

™S ADC16  HSPI SCK

DI ADC15 HSPIMISO

TCK -ADCM HSPI MOSI

GPIO12 §

GPIO13

019501 NAS dAS

52016

O§9 2101 110 £201 8201 STOMSSL, <01

g
g
o

ESP32 Dev Board PINMAP

GPIO23
GPI022

(DOTXC019221023

ENN

GPIO21

GPIO19
GPIO18

105 1018 1018 GND 1021 RXL

AN VL B )

GPIO17
GPIO16

G
102 100 104
o

Ll

|spimosI

VSPIMOSI
| Wire SCL
Serial TX
Serial RX
Wire SDA
VSPIMISO SPI MISO
VSPI SCK | | Isprsex
VSPISS |ou|sPiss
(pd)
BOOT  |ADCH{ (pu)
|ADCH2 (pd)
HSPISS  ADC13 00 (pu)|

source: github.com/espressif/arduino-esp32




image1.png
<3 | 3 GLiNet

192.168.8.1

N A @@&F &

Settings App repo Video Cloud Share UPnP server OpenVpn

SETTINGS

10.0.0.64
DHCP

GL-MT300N-V2-
((('))) e10 onN @

300M

WAN access
disabled
83

1 Devices
DVGDVX-LAB001

No devices

Firmware
2.26

3430

Reset Button Help
Lights

Wireless
Configurable
Power

A

’ * Press and hold for 3 seconds then release, your network will be
repaired. Do this if you cannot connect to the router.
«+ Press and hold for 10 seconds then release, the router will
restore to its factory settings. All data will be cleared.

Switch Button Configuration

No function (default)

Left

NANS

WkA2a10 albinaf ram B CMAAATT 200w COMAS AaA-OE-Ra-AADa-1N




